Supplement

Supplement gives you additional information on some features
that are not fully explained in previous chapters.

Layer

You will see how to create a layer, change its properties and specify
events. Layers help you place text and images at precise locations
in the browser window.

Time Line

Explains how to work with the Time Line that is used to set layer
animation effects.

Namo GIF Animator

Introduces the use of the GIF animator that has been recently
added to the Namo WebkEditor software suite. The GIF animator
allows you to create animated gif files.

Global IME

Gives you a description of the Global IME which Namo WebEditor
now supports. With the Global IME, you can enter 2 byte languages
in any Windows system.
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Layer

LAYER

One of the shortcomings of HTML is that it fails to let users place
text and images in precise locations. To supplement this
shortcoming the concept of layers was developed. The layer is one
of the features that has been added to dynamic HTML. Currently, it
only works in Internet Explorer and Netscape Navigator 4.0 or
higher.

A layer is a square-shaped editable and movable region into which
you can enter text or images. You can overlap several layers and
decide which one is displayed on top when overlapped. If you use a
style sheet and scripts, you can make the layer move in the
document according to user initiated events.

Inserting a Layer To insert a layer, select the Layer command on the Insert menu or

click the Layer button on Standard toolbar. A layer is then inserted
into the cursor position. The layer name is created automatically at
the insertion point and is displayed in the Layer List window.
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Layer Properties When you move the pointer onto the layer outline, the Properties
pointer changes to a hand. If you double click, then the Layer dialog
box appears.
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Name Enter the layer name.

Position Specify the distance between the left top of the edit

window and that of the layer. Pixels are used as the
unit in specifying the Left and Top positions.

Width/Height Specify the layer width and height. The pixel is used as
the unit in specifying the Width and Height.

Z-Index Indicates the layer display sequence. When layers are
overlapped, the layer with the larger Z-Index will be
displayed at the top. At the beginning, the background
color of the layer is specified as transparent, since the
Z-Index effect would not be seen clearly when there
are only layers that contain black characters. You can
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Layer
see the Z-Index effect more clearly when images are
inserted in layers or other colors are specified for the
background. The Z-Index is displayed in the Layer list
window.

Visibility Specify whether Namo WebEditor displays or hides the

contents of a layer. Select from Default, Inherit, Visible
and Hidden. When Hidden is specified, the content will
not be seen even in the edit window. To select an
invisible layer, click the layer mark. Select Inherit to
apply the visibility property of upper layer to the sub
layer. The visibility property of a layer is inherited by
default.

Reference You can create a layer in a layer. For example, when it is seen in
the position of the middle layer in the illustration below, the left top
layer is the upper layer and the right bottom layer is the sub layer.
When the Hidden visibility property is specified on the left top layer,
it affects the middle layer also, but not the right bottom one.
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Index.
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Background Color
Specify the background color of the layer. Netscape
Navigator doesn't display the background color and
image.

Background Image
Specify the background image. You can use clip art
suggested by Namo WebEditor by clicking the Clip Art
button on Standard toolbar.

Save using <layer> tag...
Indicates saving a layer using the <layer> tag that
Netscape Navigator can recognize. When this option is
selected, the Internet Explorer doesn't display the
layer.

Event When you click the Event button in the Layer dialog
box, the Script Wizard-Layer Action dialog box appears.
For more information on the Script Wizard-Layer
Action, see Layer Action(5-45). If you put the pointer
on 'layerl', after specifying the options as below, the
Namo WebEditor hides 'layer2' and displays 'layer2’,
when you move the pointer away from ‘layerl'.

Script Wizard-Layer Action
Enter Layer Action

Laper Name: layer 2

Event [ Action [ Taget
Drouselver Hide Layer Taper?
Drbousslut Show Layer Iaper2

1 I |
Event Type: Agtion Type: Target
[OrMousenut =] [Show Layer =] [iayerz =

B Finish Cancel Helps

You can insert interesting effects into your document if you use the
action that displays or hides layers. For example, you can create a
layer with a rollover effect that makes an answer appear when you
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SUPPLEMENT
Time Line

put the pointer on the layer asking a question. With the layer
actions specified as above, with 'layerl' as the answer and 'layer2’
as the query overlapped, when you put the pointer on 'layerl’, the
answer will be shown.

Who am I?
| am an angel!
tg?'
TIME LINE

Time Line is used to create an animation effect by moving the
position of layers successively. To animate a layer, you must use the
Time Line window. When you select the Time Line on the Tool
Windows command on the View menu or press the short cut key
<Alt+4>, then the Time Line window appears.

After selecting a layer, move it into the Time Line window by
dragging it. Then the object for animating the layer is created. This
doesn’t indicate the object itself, but the successive shift of the
layer.

You can create several layer animation objects on each layer and
specify the location and length of each object as you wish.
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Layer anchor

Layer name is
displayed on the
object, and the
circle is displayed
at the first key
frame.

SUPPLEMENT

Time Line
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The numbers on the Remave Timsline

the Time Line window,
then the short cut menu
appears. If you select Add
Object here, an object on
the current layer is added.

horizontal axis of the
Time Line window indicate
that of the frames. As the
frame changes, the layer
moves to the next
position.

Create Straight Animation

To animate the layer, specify the position of the layer when it is

animated. The position indicates where the layer is supposed to be
when the Time Line, the vertical line in red, moves from one key
frame to another. The position of the object at the first key frame is

where it appears at the time of its creation. Then specify the
position at the last key frame.
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Select the last key frame in the Time Line window.

2 In the edit window, drag the layer to the position you want, then
the path of the layer from its first position to its last one is
displayed in a solid line.

If you select the Auto Start option, you can see the layer move
along the path in the web browser.
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Select the last key frame
by clicking it.
Auto Start Indicates the animation is launched automatically as it

is specified in the Time Line window. If this option is
not selected, you must specify the Execute Time Line
action on the layer to launch the animation by
selecting Action Type at the Layer Action dialog box in
the Script Wizard menu.

Repeat Indicates the animation will be repeated.
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Time Line

Creating Curved Animation

Layer mark

To animate the layer along the curved line, use the Record Path of

Layer functionality.

1 After right clicking the Time Line window, select the Record Path of

2

Layer on the short cut menu.

If you move the layer as you want in the edit window, the path
be recorded and displayed in the Time Line window. Usually
multiple key frames are created because the curved movement
displayed in short straight lines.

will
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Add Timelie 1. Select the Record Path of the Layer.

Remove Timeline

In the web browser, you can see the layer shift rightward along
straight line and shift leftward along the curved line.

the

If the animated layer includes a sub layer, then the sub layer shifts
along with the animated layer. Because the position of the sub layer

is decided by the sub layer of the upper layer position.
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You can execute the commands below in the Time Line window.

Add Key Frame

Remove Key Frame

Change Object...

Add Frame

Remove Frame

Add Object

Remove Object

Record Path of Layer

Add Time Line
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Adds the new key frame to the current
frame on the Time Line. Between the
frames the layer moves straight, so you
must add the new key frame to change the
direction.

Removes the key frame on the current
frame.

Changes the layer to which the current
object is applied to another layer.

Adds a new frame to the current frame.
Consequently the number of frames that
makes up the object increases.

Removes a new frame from the current
frame. Consequently the number of frames
that makes up the object decreases.

Creates the objects of the current layer and
inserts it to the current position. At the
beginning the objects consist of 15 frames,
but you can increase or decrease them by
dragging the key frame.

Removes the current object. You may also
press the <Delete> key on your keyboard
after selecting the object.

Starts recording the path of the current
layer.

Creates a new Time Line. When you
animate layers that have no relations, it will
be more convenient for you to work on new
Time Line after creating them. To select the
Time Line click on the drop down button at
the top left of the Time Line window.



Remove Time Line

SUPPLEMENT
Namo GIF Animator

Deletes the Time Line that is displayed at
the time. If you delete it by mistake, you
may revive it by pressing the short cut key
<Ctrl+Z> in the edit window.

NAMO GIF ANIMATOR

The Namo GIF Animator is used to work with animated GIF files.
You can create an animated GIF file easily by attaching image files

in successive order.

Launch Namo GIF Animator in the Namo WebEditor 3.0 program
group from Start button - Programs.

To open a new window, click the New button on the toolbar, or
select the New Animation command on the Animation menu.

& Namo GIF Animator
Arimation View Help
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3 When you select the Insert Frame command on the Frame menu or
click the Insert Frame button on the toolbar, then the Insert Frame
dialog box appears. Select the image to insert and click the Open
button.

4 Open the image files to attach as above, then the image files are
displayed in the new window.

5 To change the position of the images, select the image to move by
clicking it. Then click the Move Up/Down button.
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To see the animation, press the <F5> key on your keyboard or
select the Preview command on the View menu. You can preview
the animation using the video control buttons in the Animation
Preview dialog box.
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GLOBAL IME

Microsoft Windows uses the IME (Input Method Editor) to combine
2 byte languages such as Korean, Chinese, and Japanese in a
particular way to allow them to be used in their system. The IME of
these three languages works only in the system running with the
respective languages. However, Microsoft released the Global IME
that works regardless of the languages being used in Windows.

Therefore with the Global IME and the respective language pack
installed on their computer, the users of these three languages can
use their language in any Windows system. Until February 1999,
Microsoft did not open the API for their Global IME while using it
exclusively with their products, like the Internet Explorer, Outlook
Express and Office packages.

Now Namo WebEditor 3.0 supports the Global IME. Theoretically
you can use Korean, Chinese and Japanese freely in the Namo
WebEditor 3.0 with any Windows system in any country, if the
Global IME is installed. Other languages that need no particular IME
can be entered using Unicode.

Installing Global IME

To use Korean/Japanese/Chinese in Namo WebkEditor, install the
Global IME of the respective language. You can download it from:

http://www.microsoft.com/msdownload/iebuild/ime5_win32/en/im
e5_win32.htm

After connecting to the web site, select the type of the Global IME.
Select one of the three languages and the language pack. To use
Japanese, choose “Microsoft Global IME for Japanese - with
Language Pack".
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Reference Once the Language Pack is installed, you can read the respective
language. It is possible even though your web browser is running
on Windows that use different languages. That is, you can visit a
Japanese web site using Internet Explorer with the English Windows
system. When you install the Global IME on your system, the

respective Language Pack should also be installed.
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After the download ends, double click the JAMONDO.exe on your
hard disk to install the Global IME. After installing, reboot your
computer.

Usage of Global IME After installing the Global IME, you can use Korean, Chinese or
Japanese freely in your system. To use Japanese in Namo
WebkEditor 3.0, follow the steps below:

1 Once the Global IME is installed, the icon for the Global IME is
created on the right of the Windows task bar.

|
EN

2 Launch Namo WebkEditor. If you click the Global IME icon in Namo
WebEditor edit window, the short cut menu appears offering the
following options; English, Japanese IME, and Korean IME. Select
Japanese IME. The Japanese IME is shown only in the edit window
and is not available on the HTML, Preview tab, or other dialog box.
And, of course, it is not available in other software.

English [United States)
& Japanese IME

Karean

3 If you select Japanese IME, the Japanese IME appears in the
Windows screen. The Global IME icon changes to the Japanese
IME(JA) icon. Now you can input Japanese.

4  There are three buttons in the Japanese IME. If you click the left
button, you can choose the input type of Japanese. The middle
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button is for information of Japanese Properties of the Japanese
IME, and the right button is for Help.

5 Enter the Japanese in the edit window like below.

El naname! | glb_ime |

—ABRE TEFA WebEditor * #u 3. E3EN

6 After you finish editing in Document Propertics B

Japanese, select Japanese Iioration| Appesiance Advances | o |
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Advanced tab in the Document Ereodg S -
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Document Y panese (SIS
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